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Installing, Live Updating and Connecting

Installing, Live Updating and Connecting

You Need a Personal Computer With a USB Port  

MX-950 Editor will run on any Pentium II or faster Windows PC.  Your PC should be equipped with an ade-
quate amount of RAM for the operating system you use.  MXEditor is compatible with the Windows ME, 2000,
XP and XP Pro operating systems. It is not compatible with Windows 98 or previous versions of windows.

MX-950 Editor is installed via a self extracting installer file downloadable from www.universalremote.com.
You need a connection to the internet to download the file or to update MXEditor.

Installing MX-950 Editor and Microsoft ActiveSync  

MX-950 Editor installs with a companion program for communication, Microsoft ActiveSync. You must install
both programs and if uninstalling, uninstall both programs. To install the two programs, follow these steps:

1 Connect to the internet and go to this website address:
http://www.universalremotes.com/mxeditor/downloads/MX-950setup.exe

2 A file download Window will open. Click on OPEN.

3 A warning will appear that the publisher is not verified. Click on Run.

4 The Installshield Window will then open. Click on NEXT.

Installing, Live Updating and Connecting
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Installing, Live Updating and Connecting 

5 The Destination Folder Window will open. Click on NEXT. The program will install and then show
new small window will open asking, "Install the Microsoft Active Sync 3.7". Click OK. If you already
have Active Sync, skip to step #10.

6 A new set up window will open for ActiveSync 3.7. Click on NEXT.

7 The Select Installation folder window now opens. Click on NEXT.

8 After the Active Sync Installed window opens, Click OK.

9 The InstallShield window will appear indicating that installation was successful. Click on Finish.

10 Open MX-950 Editor.

11 Check for a LIVE UPDATE by connecting to the internet normally, then clicking on the HELP menu,
then selecting LIVE UPDATE.

Tip - Keep Your Database Up to Date — USE LIVE UPDATE  

The IR code database is constantly growing with the inclusion of new devices every month. Keep your soft-
ware up to date by using the Live Update feature.  Rather than un-installing and re-installing the software, you
download updates to the software from the internet. Simply follow these steps:

a Connect to the Internet normally.

b Open MX-950 Editor

c From the Communications Menu, select Live Update

d In the Live Update window, click on Update Now.

e Wait for the window to indicate the download is 
completed. Close the Window.

f Close and re-open MX-950 Editor. You do not need to
restart Windows.

12 Once you have re-opened MX-950 Editor, connect the MX-950 to the PC via the included USB cable.
ActiveSync will chime and the icon in bottom right corner of your PC’s screen will turn green , indi-
cating that the remote is correctly communicating with MX-950 software via Active Sync. Should an
ActiveSync window offering to synchronize “personal information” appear, click on CANCEL (the MX-
950 is not a personal information manager).
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Introducing MX-950 Editor

Menus and Shortcut buttons for common tasks.  The Program Menu activates each task in the correct order.

Tree View of the MX-950 configuration.  Double clicking on any page enables you to quickly display that
page on the simulator view. Right clicking on a device or page activates a context menu.
The MX-950 Simulate View is used to navigate and to select a button to program, edit or record a macro.

Edit and Label Buttons window is used to control a buttons graphics, text and activation.

The Macro window is used to view and edit macros. 

The information bar displays whether your keyboard is cap locked or num locked. 

The important thing to remember as you program is that most Windows conventions hold true in
MX950 Editor. Explore the program menus. Hover your mouse over most of the buttons and controls
and a balloon will appear with a hint as to purpose. Navigate around the program window and
explore a little before you begin programming.

Introducing MX-950 Editor
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Programming Overview

A.  New File, Existing File on PC or in Remote  

NEW - Starting from scratch on a new job, go to the File Menu, choose New from the File Menu and
pick the type of template you would like to use to program with. None of the templates have any IR
codes, just prelabeled empty devices.  It’s just personal preference whether you rename a list of
devices or create new ones in an empty configuration.

OPEN - Open a configuration that you have worked on before and saved onto the PC hard drive. 

UPLOAD - Get a file from a client’s remote control that another installer created. Now, you can save
the file on your laptop, make any edits or changes as the client requests or the jobsite requires.

B.  Use SAVE AS   

The templates files are simply configuration files that have been preprogrammed for you.  They will keep any
changes you make. Utilize Save As to make a new file with a new file name.  All configuration files are saved
with the file extension .rcc; all device files are also saved with the extension .rcc (see D. Save and Export,
below).

TIP — Always use File | Save As to rename the file before doing any programming!  
Use the customer’s name and a rev # (i.e. SmithTheaterRev1.mxf)

C.  Use the Program Menu 

The Program Menu is your lifeline to a fast, easy programming experience.
Follow the steps in the order shown in the Menu for best results. Typically, you
will download to the remote control several times throughout this process and
test what you have done so far. You’ll need to download after finishing all pro-
gramming. For macro playback to work, you need to have downloaded.  These
downloads are not listed in the steps here in the Program Menu and are not
automatically done for you.

It is important that you do all of the tasks for each step before moving on to the
next step. Keep this manual handy so that you can verify that you have com-
pleted all of your tasks.

D.  Save and Reuse Customer Files  

Archive and save your customer files.Programming systems with similar components gets even faster when you
don’t have to redo your work over and over.  You have your own ideas about what buttons should be labeled
and how they should be arranged.  You’ll save all of your work and reuse it on the next job with similar com-
ponents and devices.

E.  Download to both Remote Controls  

For once, you have a pre-printed summary sheet and an instruction manual for the entire Home Theater! Enjoy
a brief training with your client and get home on time tonight!

Programming Overview
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Creating, Naming and Arranging Devices

A device is the basic grouping of a set of hard buttons and up to 255 soft button pages.  You will need one
device group for each remote control that the MX-950 is replacing.  You can have a maximum of 255 devices
in your configuration. When you create devices in the Create and Name Devices window, every device is
automatically linked with a jump-link to the device via either the WATCH or the LISTEN menu. If you create
devices manually you have to create a jump link from either the WATCH or the LISTEN menu button to each
device manually.

Open the Create and Name Devices Window  

You can open the Create and Name Devices window by clicking on the first item of the Program Menu or by
clicking on the Toolbar icon as shown here:

Creating Devices  

1 After the Create and Name devices window appears, select the WATCH or the LISTEN menu from
the Device list box:

2 Select the button position you’d like to create a new device name in by clicking on it. Now, decide
if you need a combined or a splt label. A split label can have up to 5 characters, a combined label
up to 11 characters. When you combine a button, IR command or Macro programming will be
duplicated automatically on both the left and the right button.

Combine both left and right buttons 
into one 11character button.

Separate a combined row 
into two separate buttons.

TIP -  Use combined row LCD buttons to type user friendly labels for important activities.  

3 Now, select the LISTEN menu from the Device List box and create all the devices for listening.

Creating, Naming and Arranging Devices
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3 You must hit the SAVE button to create all the new devices.

4 Tree View reveals the new devices you’ve created and the simulator shows the new WATCH page,
with all the new device buttons displayed.

5 Select SAVE from the File menu or click on the SAVE icon on the toolbar. 

Setting the Backlight Color of Each Device  

1 Right click on any device in Tree View (including the WATCH or the LISTEN device). Select Backlight
Color from the context menu that appears.

Creating, Naming and Arranging Devices
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2 Uncheck the Use Default Color checkbox, by clicking on it.

3 Adjust the sliders to the new color setting, then click on OK to save your changes.

TIP - Use two colors or more for the brightest backlighting!  

4 The new color now shows on the simulator.

Creating, Naming and Arranging Devices
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Using the IR Database

Applying a “Set” of IR Commands to each Device  

1 Open the Database Window - Select IR Database from the Program Menu or the Toolbar.

2 Device - In the first list box, MX-950 Editor lists the names of the devices you’ve created and named
in your configuration. Select the device you would like to program from the list box.

2 IR Data From - Select the type or category of component (i.e. TV,  VCR or DVD player) via the “IR
Data From” listbox.

3 Brand - Select the company that made the component (i.e. B & K, Sony, Krell) by clicking on the
correct brand name in the scrollable Brand window.

Using the IR Database
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4 Model - Select the exact model number from the scrollable Model window.

If the MODEL number isn’t there, DON’T test the other model numbers! Instead...  
Scroll to the bottom of the list of model numbers for your brand. There you will find a number of “Inclusive”
Code Sets. These code sets are always labeled BRAND1, BRAND2 (i.e.. Motorola1, Motorola2). Each will
operate many different model numbers. Generally speaking, if your component is a recent model, test the
higher numbered Inclusive code sets first. Here’s what the inclusive code sets look like:

5 Test the Code Set
A. Verify the MX-950 is charged and connect it to the PC via the USB port.
B. Point the connected MX-950 so that it is in range and within line of sight of the component.\
C. Power On the component.
D. Select the model number or the Inclusive Code set in the model window.
E. Click on the Test button as shown above. The only code you can test is the Power command.
F. If the component DOESN’T power off, try the next Inclusive code set.

6 Once the component powers off, click  on the Save button. 

TIP - If you’d like to drag one code to a button or test one code , use the IR Navigator, page 11.  
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7 After you click on the SAVE button, the LCD Button Editor appears, revealing the pages and codes
that will be created. Re-arrange the codes by clicking and dragging any label to any blank position.
In this screen shot, you can see that the Live TV DVR command is being dragged to an empty posi-
tion on page one. This empty position was created by dragging some less important commands to
page three. 

8 Once you have placed the most important commands
on page 1, and the less used commands on the other 
pages, click on the APPLY button.

9 Continue with the rest of the devices you need by clicking on the NEXT DEVICE button and repeat-
ing steps two through eight.

10 When you have finished all of your devices,
click on the CLOSE button.



Finding Discrete Commands for Reliable Macros

Discrete Commands versus Toggle Commands
When a remote control’s only button to turn on and off a TV set is labeled Power, it is usually a “toggle” com-
mand. Test it by pressing the button twice. If the power button turns on the TV, then turns it off, it is a toggle
command. You cannot predict whether the component will power on or not. That is a big problem when you
are programming macros! Basically, your client will feel that the macro only works half the time, and will
probably blame you for the problem.

Discrete means that the function of the command is “separate and distinct” from any other function. On a
remote control with “discrete” power commands, there are two power buttons. One that only turns the com-
ponent on, and another that only turns the component off. 

The most commonly sought “discrete” commands are for power on, power off and for TV and Surround Sound
Receiver INPUT selection. These discrete commands will make your macros work every time for your cus-
tomer. 

“Secret” Discrete Codes exist for some components. Why are they secret? Because the manufacturer
wants the remote control that accompanies the component to have the simplest appearance (fewest buttons).
Since toggles reduce the number of buttons, they make the remote control appear easier to operate. Many
manufacturers understand the needs of custom installers and build their components to also respond to dis-
crete codes.  They distribute the discrete codes via service remotes, etc. For the first time, those codes are col-
lected and integrated into our database.

Not all components respond to the discrete codes in the Database.  A component has to be BUILT to
respond to discrete codes. The fact that other models from the same manufacturer do respond to discrete codes
is the reason the codes are added to a code set. However, some models will not respond, because the manu-
facturer did not build it to respond through budgetary considerations, time constraints or a simple oversight. 

Use the IR Database Navigator to Find Discrete Commands  

1 Open the IR Database Navigator by clicking on the CUSTOM button in the IR Database window, or
by clicking on IR Database Navigator in the TOOLS menu.

11Finding Discrete Commands for Reliable Macros
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2 Select the IR DATA FROM (category of component), then the BRAND, then the MODEL. If you do
not see the model number, utilize the INCLUSIVE CODE SETS (i.e BRAND1, BRAND2, etc). Once
you see a command that has a promising sounding name, click  on it so that it is highlighted (select-
ed), then click on the TEST button. You can test any IR command in the list.

3 When you find a command that you want, simply click and drag it to the button on the simulator.

2 Finding Discrete Commands for Reliable Macros
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4 After you’ve dragged it to its new position, the new label and a pre-programmed code flag (the red
dot) is placed on the button.

TIP - Vary the number of REPEATS to sustain an IR command for a few seconds.  
Many projectors require a two or three second burst to power on or off. You
can program this to occur without the customer having to press and hold the
button for several seconds by utilizing the repeat window in IR Database
Navigator. Simply experiment with different numbers of repeats and test the
command until it works as you want it to. There is no predictable relationship
between the number of repeats and seconds from one brand to another, so
start experimenting with 10 repeats and time the burst. Once you’ve pro-
grammed a button with this extended IR command, you can use it in a macro.
The timed burst will occur as a single macro step.

Use the Universal Browser to find Discrete IR Commands  

Using the Universal Browser Window you can import LEARNED IR codes from a .ccf file, an .mxf file or an
.rcc file.  You cannot import any kind of Database codes, only LEARNED codes. 

On the internet, you can find many unusual discrete codes by browsing the files section of a website popular
with other custom installers:

www.remotecentral.com
You can often find discrete codes by posting at one of many other sites popular with custom installers by post-
ing on an online bulletin board. If any other custom installer knows of a solution he/she will email a file to
you.  Whether your download a file or if you are emailed a file from another installer, the Universal Browser
enables you to import learned codes into your MX-950 configuration.

After you’ve saved the file to your PC, you use the Universal Browser as follows:

1 Open the Universal Browser by clicking on the Universal Browser in the TOOLS menu or by clicking
on the shortcut button on the toolbar.

2 Click on the File icon to navigate to the folder that contains the file you’d like to get codes from.

13Finding Discrete Commands for Reliable Macros
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3 Use Tree View to Navigate to the Panel containing LEARNED IR codes you want. Click on the panel
name in Tree View to make the panel appear in Panel  View.

4 Click on a button in Panel View and the Action List view will reveal whether it has Learned Data or
not. Only buttons with Learned Data can be transferred.

5 Click and drag the button to the MX-950 simulator.

6 After you’ve dragged the button, the blue indicating a Learned IR command is
displayed on the button.

4 Finding Discrete Commands for Reliable Macros
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Test All Commands and Relabel for Easy Operation   

Before programming any further, you should rigorously test all of the codes you have programmed
using the IR Database and label the buttons with names that the customer will find easy to under-
stand. The best approach is to download, test all the commands, and as you test, use MX-950 Editor
to modify labels, and hide or delete unnecessary commands.

MX-950 Editor enables you use two methods to relabel and re-arrange commands and labels. Use the
LCD Button Editor method if you are most comfortable with MX-850 Editor. Use the Page View
method if you are most comfortable with MX-3000 Editor. Both have their advantages as you will see
in the descriptions below.

Using the LCD Button Editor to Relabel and Re-arrange Buttons  

Begin testing the codes you downloaded to the MX-950. Make sure that you test all buttons (hard
buttons and the LCD buttons on each page or every device). Don’t try to learn new commands yet,
wait until you can do all of them at once systematically. First you must delete commands that don’t
work and change the labeling so that your client instantly understands why you’ve made the button
available to them. Good practice is to simply delete commands that the client will never use, or to
arrange them on the last pages of a device. Certainly, your most important goal is to place the most
useful commands on the first page of a device, so that the client has everything they need without
pressing a PAGE button.

1 From the Program Menu, select Edit Buttons.

2   From the Device list box, select the first device you’d like to test and edit.

15Test All Commands and Relabel for Easy Operation

M
X
9
5
0

A
U
R
O
R
A

C
O
L
O
R

L
C
D

C
O
N
T
R
O
L
S

COMPLETE
CONTROL

™



3 Now drag any unimportant commands from the first page to the last page of the device.

4 Take a look at all the other pages, drag any buttons you consider important to the first page.

5 Select a button you’d like to convert to Single Column and click on the Single Column button at the
top of the window.

6 Test All Commands and Relabel for Easy Operation
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6 Select a button to relabel with a new easier to understand name and type it in. 

7 Repeat Steps 2-6 and continue to test all commands for all of your devices by selecting a new
device from the Device list box, then editing as needed. If you are missing a command and need to
learn it, delete any buttons that you don’t need and relabel to prepare for learning. 

Tip - It’s fastest if you don’t click on SAVE until you have finished all testing and relabeling.  
SAVE exits the Edit and Label Buttons window, so you would have to reopen it if you haven’t finished
editing all your devices.

Hiding Pages in LCD Button Editor  

A hidden page is accessible during programming so you can teach commands to buttons on hidden
pages and use them in macros. The interesting thing about hidden pages is that the end user cannot
manually access the page using the PAGE button. You HIDE pages using the HIDE checkbox which
appears at the bottom of each page in LCD Button Editor. Unlike MX-850 Editor, you can hide any
page without hiding any other.

Using Page View to Relabel and Re-arrange Buttons 

Begin testing the codes you downloaded to the MX-950. Make sure that you test all
buttons (hard buttons and the LCD buttons on each page or every device). Don’t try to learn new
commands yet, wait until you can do all of them at once systematically. First you must delete com-
mands that don’t work and change the labeling so that your client instantly understands why you’ve
made the button available to them. Good practice is to simply delete commands that the client will
never use, or to arrange them on the last pages of a device. Certainly, your most important goal is to
place the most useful commands on the first page of a device, so that the client has everything they
need without pressing a PAGE button.

1 From the View Menu, select Page View Mode.

17Test All Commands and Relabel for Easy Operation
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2 In Tree View, expand the device you would like to EDIT. In Tree View Double Click on each page of
the device to display them. You can have as many pages open as you like. 

Tip - In Page View, you can drag and drop codes from one device to another.   

3 After you’ve opened all the pages you want to edit, go to the Window Menu and select “Tile”,
“Cascade” or if you’d like to clean things up, “Close All”. Tile is usually the best option when lots of
Pages are displayed.

4 Now drag any unimportant commands from the first page to the last page of the device.

4 Take a look at all the other pages, drag any buttons you consider important to the first page.

5 Select a button you’d like to convert to Single Column and click on the Single Column button at the
top of the Button Name window.

8 Test All Commands and Relabel for Easy Operation
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6 Select a button to relabel with a new easier to understand name and type it in. 

7 Repeat Steps 2-6 and continue to test all commands for all of your devices by double clicking in
Tree View, then editing the pages as needed. If you are missing a command and need to learn it,
delete any buttons that you don’t need and relabel to prepare for learning. 

Tip - Remember to periodically SAVE your work. MX-950 Editor does not save automatically.  

Hiding Pages in Page View  

A hidden page is accessible during programming so you can teach commands to buttons on hidden
pages and use them in macros. The interesting thing about hidden pages is that the end user cannot
manually access the page using the PAGE button. You HIDE pages by right clicking on a device in
Tree View, then selecting Hide from the context menu that appears.

After you’ve hidden a page, the page is greyed out in Tree View.

Page 1 is Not Hidden

Page 2 is Hidden

Page 3 is about to be changed to
Hidden via the right click con-
text menu.

19Test All Commands and Relabel for Easy Operation
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Learning

Learning should be a last resort for professional installers. We make every effort to provide you with
any codes you need via our database. If they are not, please make a note to email us at the first
chance with the learned file you created, the type of device it is and the Brand and Model Number. If
it is not a current model component, we would still like to add it to the database, but please note in
your email the approximate age of the component. Please address your emails to:

IRDatabase@universalremote.com

Tips for Learning from Unusual Devices  

When you have difficulty successfully teaching codes to the MX-950, always try these tips in the order below:

1. Fresh Batteries in the Original Remote Control - Weak batteries will cause MX-950 Editor
to fail to correctly learn.  Note that EVEN if the original remote still operates the component,
the batteries can be too weak to produce a strong enough carrier for any learning remote con-
trol to detect!!!! When a code fails, replace the batteries FIRST!

2.  Tap instead of Pressing and Holding - With buttons that the client will only tap when using,
this may produce better results. Normally, you should press and hold. 

OR

2. The “Flutter” Technique - If you are having problems with a Code that has to be sustained
(like volume up or down), sometimes fluttering the button on the original remote at least seven
times while you are learning will successfully teach the code.  

3. Vary the Distance between the Remote and the Learning Sensor - We recommend that you
start with a distance of half an inch between them. If no other technique works, try varying the
distance by doubling it each attempt. Keep trying until you are at least 5 feet away.

4. Try Standalone Learning, see page 23.

5. Call our technical support department at 1-800-901-0800 to see if they have a cross refer-
ence for the brand and model you are using. If there isn’t a cross reference, they will ask
you to ship the remote to our engineers so the codes can be added to the database.

Learning IR Codes One at a Time  

When all you need is a code or two, this is the method to use. If you need to teach an entire set of codes from
a remote control, skip to the Batch Learning section on page xx.

1 Connect the MX-950 to your PC and verify that the ActiveSync icon in the lower right hand corner
of your PC screen is green.

Learning
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2 Select the button that you want to teach to by single clicking it on the simulator.

3 Click on the LEARN Tab or choose Learn from the Program. There will be a pause, while the PC
communicates with the MX-950, then the info window will display “Ready”.

4 Press and hold the corresponding button on the original remote control while pointing it at the top
of the MX-950 (head to head) with the remotes approximately a half inch to an inch apart. When the
code is successfully learned, the window will say GOOD, confirming that the code learned “correct-
ly.”  Actually, the GOOD means that the code might be good.... You need to test it. Select the code
in the Current Learned IR List, then click on the test button while pointing the MX-950 at the device.

TIP - Always POWER OFF the RF Base Station when testing Learned Codes. Test line-of-sight only!
If there is any interference or IR saturation, your tests will fail, not because of learning issues but
because of RF setup issues. Don’t waste time, test your codes now, test RF setup later. 

Learning

The Learn Button re-activates the Learning process when it auto-
matically times out or if you want to re-learn a command.

The Learning Information window prompts you when the system
is Ready to learn a new command and when a learned com-
mand is Good, or if it Fails.

The Learn Tab reveals the toolbar for Learning.
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5 If the code doesn’t operate the component you can try the DoubleTap learning method. This is par-
ticularly useful for components using the Philips RC5 ‘togglebit” protocol.  Many high end audio
companies use these codes. Just click on the 2 Time Learn radio button and you will be prompted to
learn every code twice.

6 Click on SAVE - You must click on SAVE to save the LEARNED command. The blue “L” learned flag
appears on the button you taught the command to.

Learning a Batch of Buttons Quickly  

Using this method, MX-950 software will automatically save and select the next button, saving lots of time
when you are learning an entire remote control. Key to your success are two tips:

Tip #1 - Always label all your buttons before beginning  

Tip #2 - Verify with one button that the codes from the new remote learn normally.  

Once you’ve prepared, batch learning goes very quickly:

1 Select the STARTING Button - Select the button that is the top left of the buttons you want to teach
to.  When MX-950 Editor automatically saves and selects the next button it moves left to right, unless
it is learning a group of buttons with similar functions. When you are batch learning the Volume
Group, MX-950 Editor first learns Volume Up, then Volume Down, then Mute, then advances to the
next group. 

2 Select  both the LEARN and the CONTINUE button - The combination activates the batch learning
capability of MXEditor. It is normal for MX-950 Editor to time out after learning the LCD page, and
again after learning the hard buttons. The CONTINUE button remains selected, but you must restart
the batch learning by selecting a new starting button on another LCD page or device, then selecting
LEARN again.
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3 Watch the LEARNING Window - When the info window says READY, press and hold the button on
the original remote control. When it says GOOD, release the button. If it says FAIL, reteach the same
command.  When you see that a new button has been selected and the LEARNING window says
READY, then teach the new command from the original remote control.  

Tip - To skip a buttons in the automatic sequence, select the next button you want.  

Tip - You can test any code by selecting it on the simulator and clicking on the TEST button. 

4 Remember to save your work, go to the File menu and select SAVE. 

Standalone Learning  

With some PC’s, the interconnection between the Operating System (Windows) the USB interface, the remote
and the software can create learning problems with any code. If you have tried all of the tips listed on Page 20,
it is worth trying Standalone Learning.

1 From the Communications Menu, select Remote Control Setup. You may have disabled the
Standalone Editing feature. Make sure that the Disable checkbox is UNCHECKED.

2 Download to the remote control. Now all your buttons are correctly labeled.

3 Disconnect the remote from the USB cable.

4 Press and hold both the LISTEN button and the ENTER button for five seconds. The EDIT menu will
appear. 

5 Select the LEARN button from the EDIT menu on the MX-950.

6 Choose between an LCD button on either the LISTEN or the WATCH pages (DEVICE BTN) or a nor-
mal LCD or hard button within one of your devices (BUTTON). The top of the page now displays
LEARN. 

7 Navigate to the button you want to teach and select it. The top of the page now changes to READY.
Teach the command you want, observing the top of the page. If it says FAIL, reteach it. If it says GOOD,
then LEARN, select the next button you want and teach to it. When you are finished, simply press
WATCH or LISTEN several times until the MX-950 is back in normal operating mode. 

8 Now, upload to the PC and save the file.

Learning

Select Remote Control Setup from
the Communications Menu.

Make sure the Disable checkbox
is UNCHECKED (as shown).

Then, click on OK to close the
window.
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Macro Programming

Bullet Proof Macros or Point N Pray?  

Professional Installations Require “Bullet-Proof” macros (all discrete codes or workarounds, no toggle
commands). A Point and Pray macro is created when you place a toggle command in the macro (like
a TV Power command). The use of Point & Pray macros that only work if the customer follows strict
rules will create service calls and a lot of bad will (for example, you force the customer to verify that
the system is completely off before using the TURN ON macro). When you cannot find discrete
power commands, create an extra device called “POWER” or “SYSTEMPOWER” and give your client
one place to find all the power commands. Instruct them to power on their system manually from this
easy, convenient page, then return to WATCH or LISTEN to use the automated input switching Macros
for the ACTIVITIES like Watching CABLE, Watching a DVD movie etc. -  For systems with lots of tog-
gle Power codes, create
a “Power” HELP list.  

Finding Workarounds When There Are NO Discrete Codes  

By creatively experimenting you may find that you can workaround the lack of discrete codes. This takes time
and there is no guarantee that you will find a workaround for any given component.  Here are some common
examples:

DVD and  VCR Power Workaround
Most DVD players will turn on when off when they receive a Play command. Thus you can workaround like
this:

DVD ON = 1) Play DVD OFF   = 1) Play 
2) DVD Stop 2) A delay of 2 to 4 seconds

3) DVD Power (toggle command)

TV scrolling “INPUT” Workarounds
Many televisions respond to a channel up or a channel number command by changing to the Antenna input
regardless of what input was last selected. This creates an “anchor” action that puts the television in a known
input. Thus you can create a workaround as follows:

EXAMPLE - CH Up takes TV to the ANT A input (and the TV has 5 inputs -Ant A, Ant B, EXT1, EXT2 and EXT3)

Macro Programming

In this example, the program-
mer has created a device called
SYSTEMPOWER. The client has
one convenient page to power
up their system manually. 

Each button is labeled for the
power command the program-
mer has placed via the IR
Database Navigator.

This is much better technique
than programming a Point N
Pray Macro that will result in
much customer frustration.
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TV to EXT3 = 1) Ch Up (takes TV to ANT A regardless of what input was last selected)
2) Input (takes TV to next input - ANT B)
3) Input (takes TV to next input - EXT 1)
4) Input (takes TV to next input - EXT 2)
5) Input (takes TV to desired input - EXT 3)

Using the Macro Window  

The Macro Window controls macro recording as follows:

Tip - All Buttons Can Be Macros except the Watch, Listen and Page buttons.  

Macro Programming

Record- This is the fastest way to record
a macro. Select a button, click on
Record, then use TREE View to navigat
to the device and page of a button you
want. When you click on the button, it is
added to the macro as a macro step. 

Test Macro - Play back your
macro by following these steps:

1) Select the first step in the
macro.

2) Connect to an MX-950

3) Click on the TEST button. 

Draggable Macro Steps - In this
window, you can view all of your
macro steps. You can click and
drag any step to any position,
changing the order of the macro.

Delay -  Click to open the delay win-
dow. Any step can be a deleay between
.1 and 99.9 seconds. Longer delays can
be created by using more than one
delay. 

Save - Click to stop Macro Recording
and save your work.

Jump -  As the last step in a
Macro, you can specify a jump to
any page of any device.   You can
program another jump in the
macro to display a page with a
status feedback message or
image.

Delete -  First select the step you
want to delete, then click on this
button (or the Delete key on the
keyboard.

Import a Macro -  First select the
the button without a macro, then
click on this button, then click on
the button that has the macro you
want imported.

IR Data -  Click on this to open IR
Database Navigator, then drag a
code from the Navigator to a
macro step.

SET VARIABLE Opens the Set
Variable window, which enables
you to pick an already-created
variable and set it to 0, 1 or to
simply Invert its status.

Sound -  Any step can have a sound
WAV file programmed by dragging a
sound from the sound gallery to the
macro. However, to program a second
sound file in the same macro (so that
there is a beep at the beginning and a
“tada” at the end of a macro), you must
program a delay in between the two
sounds as long as the first sound or
longer.

Normal, Press and Hold and
Variable List Box -  
A “Normal” macro has one
sequence of steps that will always
playback when the button is
pressed.

A “Press and Hold” macro has
two sequences, one sequence is
played when the button is pressed
normally. The other sequence is
played when the button is pressed
and held for longer than the spec-
ified time.

A “Variable” macro has two
sequences. One sequenc e is
played back when the selected
variable=0, the other when the
variable=1. 

Text -  Any step can make the button
label change. If you want the label to
stay changed, insert a delay after the text
step to keep the text on for enough time
for your client to read it.
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Programming a System Power On Macro  

Set up your laptop and the connected remote within operational range of the home theater system
while programming a macro. Macros that the client will use to turn the system on require extensive
testing of delays and you can expect to do a lot of experimenting while programming.

In this example, the WATCH device’s ON button is programmed to turn on the system, configure all
the Inputs and Modes for the client’s favorite activity, watching HDTV Cable TV.

1 In Tree View, navigate to the WATCH device. On the simulator, select the On button.

2 Verify that the Type list box at the bottom of the Macro Window has the default NORMAL selected. 

3 Click on the RECORD icon or select Macro from the Program Menu.

4 In Tree View, expand all the pages of the devices you are going to
power on. Navigate to the first device you’d like to turn on. Since the
Plasma TV in the example system takes several seconds to warm up, 
it is the first device we’ll turn on. With single clicks on the pages
inside the Plasma TV device we find the P-On command on Page 3.

4 On the simulator, click on the button with the device’s Power On command.

The new step appears in the Macro spread sheet:

Macro Programming



27Macro Programming

M
X
9
5
0

A
U
R
O
R
A

C
O
L
O
R

L
C
D

C
O
N
T
R
O
L
S

COMPLETE
CONTROL

™

4 Program steps to power on the other components in the system. In this example, the cable box is
powered on all the time, since it is a DVR, so the only other component to power on is the surround
sound receiver.

5 Program steps to select the correct TV and Receiver input for the client’s favorite activity. In this
example the client’s favored activity is watching Cable TV. The cable box is connected to the TV
input of the Surround Sound receiver and the component output of the cable box is directly con-
nected to the Plasma TV’s Video 5 input.

6 Program a jump to the Device and Page they use for their favorite activity.
Click on the JUMP icon. 

7 Select the correct device and page from the Jump window. The jump appears in the Macro window
in the column under Jump.

8 Now, test if delays are necessary in your macro. First, turn the TV and the Receiver to the wrong
input, then turn off everything in the theater.  Point the connected MX-950 at the system. Select the

first step in the list by clicking on it. Now, click on the TEST button. Observe the television and
the receiver. Did they both switch to the correct input?

In the example system, the TV requires four seconds of warmup before the Input will correctly
change. The surround sound receiver requires two seconds, so we program a four second delay after
the TV and the Receiver power on.
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9 Select the Delay icon , then when the delay window opens, click on the preset amount of delay
or enter any time between .1 second and 30 seconds in the “Customize” window.

11 The new step appears in the list. Now, drag the delay step to the correct location.

TIP - Sometimes a change in order can provide the delay you need. 
Each IR command lasts approximately 1/3 of a second, so if you have 3 commands, one second has
elapsed. 

12 Again, turn the TV and the Receiver to the wrong input, then turn off everything in the theater.  Point
the connected MX-950 at the system. Select the first step in the list by clicking on it. Now, click on
the TEST  button. Observe the television and the receiver. Did they both switch to the correct input?
Continue to revise the macro with delays or changes until the macro ALWAYS correctly turns every-
thing on and switches the surround sound receiver and television to the correct input. When the
macro is perfect, click on the SAVE in the Macro Window.

13 Remember to save your work, click on SAVE in the File Menu.
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Programming a Power Off Macro  

A Power Off macro is much simpler than a Power On macro, since there are rarely any delays to test, etc.
Usually, to give the client some feedback that the macro is working, the TV is turned off first.

When you are forced to “workaround” a DVD player or  VCR without a discrete off command, you will make
the macro more reliable if you place the time consuming anchor (the play command) at the beginning of the
macro.  Make sure that you turn the DVD player off before testing this kind of workaround.  You are testing the
worst case, you know that a toggle type power command will turn the DVD player off, you are concerned
about an event that might happen. The DVD player is already off, but the client presses the MAIN Power Off to
turn everything else on. If you only programmed a toggle Power command, everything else would turn off, but
the DVD player would turn on. This “workaround” ensures that the DVD player turns off.

Finally, so that this macro will work correctly when you set up Punch Through, program a jump to the WATCH
pages. Thus if the user presses OFF after watching a DVD movie, the MX-950 will jump to the WATCH device,
perfect for picking up the remote tomorrow night! 

Copying or Importing Macros for Activity Macros  

You can often speed programming by instantly inserting all of the steps of a previously programmed macro as
the starting point of a new macro. The inserted steps are completely editable, without changing the original
macro.

1 Do not start recording at the new location. Simply select the button where you would like the macro
inserted. Then click on the
IMPORT button.

2 Navigate to the device and page where the original macro is programmed. Click on the button that
contains the macro. All of the steps are copied/cloned into the new button location.

4 Edit as needed and click on SAVE.

Tip - Copy and Paste Macros  
You can first select the button with a Macro, select Copy from the Edit Menu, then select the button
without a macro and select Paste from the Edit Menu. The keyboard shortcuts for Copy are Control|C,
for Paste Control|V.

Macro Programming



Push and Hold Macros  

By selecting this option, you now have the ability for one button to issue two different macros. One macro is
issued if the button is pressed briefly, another completely different macro is issued if the button is pressed and
held. Here is a way to use Push and Hold macros that we think you might find useful for power user clients.

Power users constantly switch devices and make adjustments to different components so waiting for the
Activity macros to finish reconfiguring their system can be frustrating to them. By programming each of their
activity macros to only issue when they press and hold the button for two seconds, you can program each but-
ton to simply Jump to the device when they tap the button.

Here’s:

1 Select the button you’d like to program with two different macros.

2 S elect Press-Hold Mode from the Type list box at the bottom of the Macro Window. Then, set the
TIME in the Options window to 2 seconds. This ensures that the client will have to Press and Hold
the button two seconds to issue the Macro.

3 Click on the Tab at the bottom of the Macro Window labeled BEFORE, then program a jump to the
device only.

When the client presses the button for less than 2 seconds, only the jump occurs.
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Macro Programming



4 Click on the Tab at the bottom of the Macro Window labeled AFTER, and program the full macro (in
the example shown; everything this system needs to Watch a DVD). 

Tip - Reverse priority for systems with both casual users and power users...  
Program the simple jump to occur after a press and hold, while the Activity macros occur with
a normal tap.

Variable Macros  

This another method for one button to issue two different macros. One macro is issued when the button is
pressed and a particular variable is “0”, another completely different macro is issued if the button is pressed
and the same variable is now equals “1”.

Variables allow you to track when a particular button has been pressed. Then when another button is pressed,
you can do something different based on the previous button press. 

Clever use of variables can enable you to add all kinds of elegant improvements to operation. Here’s an exam-
ple of variables, used in this case to remove the delays in the activity macros on the Watch page once the pro-
jector is on.

1 The macro to turn on the system and watch Cable TV is very long in this example system. The pro-
jector requires 25 seconds to warm up before the inputs can be changed. 
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2 In the Type list box at the bottom of the Macro Window, select Variable as the type.

3 In the Variable list box that now appears, select New Variable.

4 In the New Variable window that opens, type in a descriptive name, then click on OK.

5 Verify that the new variable name appears in the Variable window as the selection. 

6 Now your macro window displays two different tabs. One is the macro that will be sent when the
projectorpower variable = 0, the other when the projector power variable = 1. Program the macro in
Variable=0 with the Power On commands and the delay, while the macro in Variable=1 does not.
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ProjectorPower Variable = 0 ProjectorPower Variable = 1



Tip - You must program all your activity and power macros to be Variable macros  
Now, you must program all macros that the client might use to turn on the system with a variable
change that changes the variable ProjectorPower to “1”. Thus no matter what button you use to turn on
the system, the MX-950 will know the true status of the projector is on. Likewise all macros that turn
the system off must change the variable ProjectorPower to “0”.  

7 In all macros that power on the projector, repeat steps 1-7, then add a new step to all the macros.
Click on the Set Variable button on the macro toolbar.

8 The Set Variable window opens. Select the ProjectorPower variable and set it to a state of 1 (indicat-
ing that the projector is now powered on). Afterwards, the new step appears in the macro list. 

9 In all macros that power OFF the projector add a new step to the macros. Click on the Set Variable
button and set the Projector Power variable to equal “0” after the projector is off.
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Using Sounds

Setting the Default Sound  
MX-950 Editor enables any button to have a sound play when the button is pressed. You can set a default
sound for every button throughout the configuration as follows:

1 From the File menu select User Preferences. The User Preference window will open.

2 Select one of the three options:

None - Your buttons will only make sounds if you drag a sound from the sound gallery to a button.
Default Beep - Whenever a button that has an IR command or macro is pressed, the MX-950 will beep.
User Defined - You browse to a file location and select a wav file that will play whenver an active but-

ton is pressed.

Using the Sound Gallery  
MX-950 Editor enables you to program any button with as many sounds as you like. However, for each sound,
you must program a delay after the sound, long enough for the sound to play completely. To use sounds, click
on the Sounds icon in the macro toolbar, or select Sound Gallery from the Tools Menu. Simply drag a sound
into a macro, then place the optimum delay after each sound.  

Using the Image Gallery  

The MX-950 has a limited ability to use images instead of text. First, make sure you are in Simulator and Page
View mode, then double click on the page you want to place an image as a button label. Double clicking
opens a new Page View and sets the Simulator to the same page. Now, from the tools menu, open the Image
gallery. Drag an image from the gallery to the Simulator View. Simulator View distorts the size of the image,
but allows you to drag the image to any position on the page. Page View gives you a much better idea of what
the image will look like, but does NOT allow you to drag or delete the image. By using both views side by
side, you control the image position in Simulate View, but judge it’s position in Page View. 

Sounds and Images

In this example four sounds play
back when the button is pressed.
For each sound to play, a delay
must be placed after it.

By using both
Simulator and Page
views side by side,
you control the
image position in
Simulate View, but
judge it’s position in
Page View. 

You can import bmp
or jpg images to the
gallery, however,
they cannot be larg-
er than 64 pixels by
88 pixels.
They can be four
color (black, white,
light grey and dark
grey).
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Programming Punch Through

Punch Through allows you to set the same functions on all devices very quickly.  You can punch through any
of the groups of buttons on the MX-950. In this exampe, the Power On and Power Off buttons on every page
and every device are set to punch through to the WATCH Power On and Power Off buttons, thus the user can
power off the system without returning to WATCH to press Power Off. Likewise, the Volume Up, Down and
Mute have been set as a group to punch through to the surround sound receiver. After programming, flags
remind the programmer that the buttons have been set to punch through.

1 Open the Punch Through window by clicking on the shortcut button in the toolbar or by selecting
Punch Through from the Program Menu.

2 Select the devices which you want to change programming by clicking on them
while holding down the CONTROL key on the keyboard.  If you want them all
selected (normal for Volume Up, Down and Mute), simply click on the Select All
button.  Any device you select will be HIGHLIGHTED in the “Punch To” list.

3 Select the device that has the codes you want used in the Punch From list.

4 Click on SAVE.  Check the devices you programmed, you should see the red PT (Punch Through)
flag on every button affected on all the devices you programmed:

Punch Through
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Programming RF Control Options

The RF Setup Window  
The RF Setup window opens after selecting RFControl from the Program Menu or
clicking on the shortcut button.

Adjusting Signal and IR Output Options  

The RF Setup window enables you to adjust the properties of RF Control by clicking on the intersection of a row and a
column and then selecting from the pull down list box the property you want. All of your devices are displayed.  You can
set each device individually to be controlled by clicking on the cell you want to change. After clicking, a list box of
options will appear.

SIGNAL controls how the MX-950 will send
commands:

IR and RF - Both RF signals and IR com-
mands are sent from the MX950.
The RF signals will also be
issued as IR commands by the
MRF-300. 

IR  - Only IR commands are sent from
the MX950, as a result the MRF-
300 does not send any com-
mands.

RF - Only RF signals are sent from the
MX950, as a result only IR com-
mands from the MRF-300 are
received by the device.

RECEIVER enables you to select which MRF-300
receiver will receive the commands for this
device. Thus, you can send commands to a
device in another location via a second MRF-
300 placed in that location (up to 16 in one
house).

Note: In a system with only one MRF-300
receiver, this does not need to be adjusted.

RF Control 
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IR OUTPUT controls the Line Outputs for
Flashers affixed to the front panels of compo-
nents. You can opt to either send IR
Commands to:

ALL - The commands are sent to all of
the Flashers

1-6 - Just the specified Flasher
receives the IR commands
(Useful when identical TV’s or
VCR’s are utilized in the system)

Adding RF Base Stations, Conguring ID#’s and Front Blasters  

To add a new receiver to the list, to change the Receiver ID# of your existing receiver or to enable/disable the Front
Blaster, click on the Receiver button of the RF
Control window.

RF Control

You may rename a receiver to something
more descriptive by first selecting the
receiver’s name cell, then clicking on the
Rename button.

If you want the Front Blaster turned OFF on
any receiver, reset it by clicking on the cor-
rect CELL and selecting OFF.

NOTE: In some installations, the MRF-
300’s Front Blaster is so powerful that it
can overload nearby components and
give poor or intermittent operation. Try
re-positioning the MRF-200 to reduce the
power flooding the cabinet or turn the
Front Blaster off.

After pressing the Receivers button, the RF
Control Window will enlarge revealing the
Receiver configuration options. Again, you
click on a cell to adjust.

The Receiver ID cells enable you to change
the ID# of each receiver, so that commands
for one will be ignored by the other if set to
different ID’s. 

Note that in this system, the MRF-300 in the
eq uipment closet is set to ID#2 and the
MRF-300 connected to the identical TV’s is set
to ID#1.



38

U
S
I
N
G

M
X
9
5
0

E
D
I
T
O
R

T
O

P
R
O
G
R
A
M

Enable or Disable Standalone Editing

You can disable the Edit menu of the MX-950. This is the menu that appears when you press and hold LISTEN
and ENTER for five seconds. Though the ability to change the labels and to learn codes standalone is useful to
some installers, you may want to prevent your customer from accessing these settings. 

1 Open the Remote Control Setup window by selecting it from the Communications Menu.

2 Check the Disable checkbox if you want to prevent anyone from accessing the Edit menu on the
MX-950. Click on OK when you’ve made your changes.

TIP - You cannot disable the MX-950 Settings Menu.  
The Settings menu appears when WATCH and Enter are pressed and held for five seconds. This menu is
the only way for the client to set the clock.

Enable or Disable Standalone Editing
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Downloading to MX-950

You download to the remote control by:

1 Make sure the remote control has charged batteries. 

2 Connect the cable between the PC and the remote control.

3 Verify that the file you have open in MX-950 Editor is the one you want to download to the remote
control.

4 Click on the Download to Remote Control shortcut button on the toolbar or choose Download from
the Communications Menu. Do not move the mouse or touch the keyboard during the download.

TIP - Make sure that the cable plug is solidly connected at both ends.    

Using the Setup Menu

1 Press and Hold both the WATCH and the ENTER button for five seconds.

2 Once the Setup menu appears, you can browse between it’s two pages via the PAGE buttons. It will
automatically time out, or you can press the WATCH or the LISTEN button to exit. 

TIME - Set the clock here, however if you want to change whether it is displayed or not, go to
INDICATOR on page 2 of the Setup Menu.

BACKLIGHT - Configure the amount of time that the MX-950 will stay lit after it is picked up.
DISPLAY - You can adjust the brightness and contrast of the display. Keep the setting of color set

to S/W, thus all your changes of device backlighting color will be displayed.
SOUND - You can adjust the Volume of the MX-950 speaker
PICKUP - You can disable the Pick Up Sensor
INDICATOR  - You can disable the display of the Clock, the IR and the Battery Indicator here.

Finishing the Program
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500 Mamaroneck Avenue
Harrison, NY 10528

Phone: (914) 835-4484 
Fax: (914) 835-4532 

www.universalremote.com

COMPLETE
CONTROL

™

Universal Remote ControlBY
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